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				Introduction

				I’m very proud to present you with Excel 2010 For Dummies, Portable Edition, the latest version of everybody’s favorite book on Microsoft Office Excel for readers with no intention whatsoever of becoming spreadsheet gurus.

				Excel 2010 For Dummies, Portable Edition, covers all the fundamental techniques you need to know in order to create, edit, format, and print your own spreadsheets. This book concentrates on spreadsheets because spreadsheets are what most regular folks create with Excel.

				About This Book

				This book isn’t meant to be read cover to cover. Although its chapters are loosely organized in a logical order (progressing as you might when studying Excel in a classroom situation), each topic covered in a chapter is really meant to stand on itsown.

				Each discussion of a topic briefly addresses the question of what a particular feature is good for before launching into how to use it. In Excel, as with most other sophisticated programs, you usually have more than one way to do a task. For the sake of your sanity, I have purposely limited the choices by usually giving you only the most efficient ways to do a particular task. Later, if you’re so tempted, you can experiment with alternative ways of doing a task. For now, just concentrate on performing the task as I describe.

				As much as possible, I’ve tried to make it unnecessary for you to remember anything covered in another section of the book. From time to time, however, you will come across a cross-reference to another section or chapter in the book. For the most part, such cross-references are meant to help you get more complete information on a subject, should you have the time and interest. If you have neither, no problem. Just ignore the cross-references as if they never existed.

				How to Use This Book

				This book is similar to a reference book. You can start by looking up the topic you need information about (in either the Table of Contents or the index), and then refer directly to the section of interest. I explain most topics conversationally (as though you were sitting in the back of a classroom where you can safely nap). Sometimes, however, my regiment-commander mentality takes over, and I list the steps you need to take to accomplish a particular task in a particular section.

				What You Can Safely Ignore

				When you come across a section that contains the steps you take to get something done, you can safely ignore all text accompanying the steps (the text that isn’t in bold) if you have neither the time nor the inclination to wade through more material.

				Whenever possible, I have also tried to separate background or footnote-type information from the essential facts by exiling this kind of junk to a sidebar (look for blocks of text on a gray background). Often, these sections are flagged with icons that let you know what type of information you will encounter there. You can easily disregard text marked this way. (I’ll scoop you on the icons I use in this book a little later.)

				Foolish Assumptions

				I’m going to make only one assumption about you (let’s see how close I get): You have access to a PC (at least some of the time) that is running Windows 7, Windows Vista, or Windows XP and on which Microsoft Office Excel 2010 is installed. Having said that, I don’t assume that you’ve ever launched Excel 2010, let alone done anything with it.

				[image: warning_bomb.eps]	This book is intended for users of Microsoft Office Excel 2010. If you’re using Excel for Windows version Excel 97 through 2003, the information in this book will only confuse and confound you because only Excel 2007 works similar to the 2010 version that this book describes.

				If you’re working with a version of Excel earlier than Excel 2007, please put this book down slowly and pick up a copy of Excel 2003 For Dummies instead.

				Conventions Used in This Book

				The following information gives you the lowdown on how things look in this book. Publishers call these items the book’s conventions (no campaigning, flag-waving, name-calling, or finger-pointing is involved, however).

				Keyboard and mouse

				Throughout the book, you’ll find Ribbon command sequences (the name on the tab on the Ribbon and the command button you select) separated by a command arrow, as in:

				HomeCopy

				This shorthand is the Ribbon command that copies whatever cells or graphics are currently selected to the Windows Clipboard. It means that you click the Home tab on the Ribbon (if it isn’t displayed already) and then click the Copy button (that sports the traditional side-by-side page icon).

				Some of the Ribbon command sequences involve not only selecting a command button on a tab, but then also selecting an item on a drop-down menu. In this case, the drop-down menu command follows the name of the tab and command button, all separated by command arrows, as in:

				FormulasCalculation OptionsManual

				This shorthand is the Ribbon command sequence that turns on manual recalculation in Excel. It says that you click the Formulas tab (if it isn’t displayed already) and then click the Calculation Options button, followed by the Manual drop-down menu option.

				Although you use the mouse and keyboard shortcut keys to move your way in, out, and around the Excel worksheet, you do have to take some time to enter the data so that you can eventually mouse around with it. Therefore, this book occasionally encourages you to type something specific into a specific cell in the worksheet. Of course, you can always choose not to follow the instructions. When I tell you to enter a specific function, the part you should type generally appears in bold type. For example, =SUM(A2:B2) means that you should type exactly what you see: an equal sign, the word SUM, a left parenthesis, the text A2:B2 (complete with a colon between the letter-number combos), and a right parenthesis. You then, of course, have to press Enter to make the entry stick.

				Occasionally, I give you a hot key combination that you can press in order to choose a command from the keyboard rather than clicking buttons on the Ribbon with the mouse. Hot key combinations are written like this: Alt+FS or Ctrl+S (both of these hot key combos save workbook changes). 

				With the Alt key combos, you press the Alt key until the hot key letters appear in little squares all along the Ribbon. At that point, you can release the Alt key and start typing the hot key letters (by the way, you type all lowercase hot key letters — Ionly put them in caps to make them stand out in the text).

				Hot key combos that use the Ctrl key are of an older vintage and work a little bit differently. You have to hold down the Ctrl key while you type the hot key letter (though again, type only lowercase letters unless you see the Shift key in the sequence, as in Ctrl+Shift+C).

				Excel 2010 uses only one pull-down menu (File) and one toolbar (the Quick Access toolbar). You open the File pull-down menu by clicking the File tab or pressing Alt+F. The Quick Access toolbar with its four buttons appears to the immediate right of the File tab.

				Finally, if you’re really observant, you may notice a discrepancy in how the names of dialog box options (such as headings, option buttons, and check boxes) appear in the text and how they actually appear in Excel on your computer screen. Iintentionally use the convention of capitalizing the initial letters of all the main words of a dialog box option to help you differentiate the name of the option from the rest of the text describing its use.

				Special icons

				The following icons are placed in the margins to point out stuff you may or may not want to read.

				[image: technicalstuff.eps]	This icon alerts you to nerdy discussions that you may well want to skip (or read when no one else is around).

				[image: Tip.eps]	This icon alerts you to shortcuts or other valuable hints related to the topic at hand.

				[image: remember.eps]	This icon alerts you to information to keep in mind if you want to meet with a modicum of success.

				[image: warning_bomb.eps]	This icon alerts you to information to keep in mind if you want to avert complete disaster.

				Where to Go from Here

				If you’ve never worked with a computer spreadsheet, I suggest that you first go to Chapter 1 and find out what you’re dealing with. Then, as specific needs arise (such as, “How do I copy a formula?” or “How do I print just a particular section of my worksheet?”), you can go to the Table of Contents or the index to find the appropriate section and go right to that section for answers.

				Please note that some special symbols used in this eBook may not display properly on all eReader devices. If you have trouble determining any symbol, please call Wiley Product Technical Support at 800-762-2974. Outside of the United States, please call 317-572-3993.  You can also contact Wiley Product Technical Support at www.wiley.com/techsupport.

				

				

				

			

		

	
		
			
				Chapter 1

				The Excel 2010 User Experience

				In This Chapter

				[image: arrow] Getting familiar with the Excel 2010 program window and BackstageView

				[image: arrow] Selecting commands from the Ribbon

				[image: arrow] Customizing the Quick Access toolbar 

				[image: arrow] Methods for starting Excel 2010

				[image: arrow] Surfing an Excel 2010 worksheet and workbook

				[image: arrow] Getting some help with using this program

				The Excel 2010 user interface, like Excel 2007, scraps its reliance on a series of pull-down menus, task panes, and multitudinous toolbars. Instead, it uses a single strip at the top of the worksheet called the Ribbon that puts the bulk of the Excel commands you use at your fingertips at all times.

				Add to the Ribbon a File tab and a Quick Access toolbar — along with a few remaining task panes (Clipboard, Clip Art, and Research) — and you end up with the handiest way to crunch your numbers, produce and print polished financial reports, as well as organize and chart your data. In other words, to do all the wonderful things for which you rely on Excel.

				Best of all, this new and improved Excel user interface includes all sorts of graphical improvements. Foremost is Live Preview that shows you how your actual worksheet data would appear in a particular font, table formatting, and so on before you actually select it. Additionally, Excel 2010 supports an honest to goodness Page Layout View that displays rulers and margins along with headers and footers for every worksheet and has a zoom slider at the bottom of the screen that enables you to zoom in and out on the spreadsheet data instantly. Finally, Excel 2010 is full of pop-up galleries that make spreadsheet formatting and charting a real breeze, especially in tandem with Live Preview.

				Excel’s Ribbon User Interface

				When you launch Excel 2010, the program opens the first of three new worksheets (named Sheet1) in a new workbook file (named Book1) inside a program window like the one shown in Figure 1-1.

				[image: 9781118315248-fg0101.eps]

				Figure 1-1: The Excel 2010 program window that appears immediately after launching the program.

				The Excel program window containing this worksheet of the workbook contains the following components:

				[image: check.png] File tab that when clicked opens the new Backstage View— a menu on the left that contains all the document- and file-related commands, including Info (selected by default), Save, Save As, Open, Close, Recent, New, Print, and Save & Send. Additionally, there’s a Help option with add-ins, an Options item that enables you to change many of Excel’s default settings, and an Exit option to quit the program.

				[image: check.png] Customizable Quick Access toolbar that contains buttons you can click to perform common tasks, such as saving your work and undoing and redoing edits.

				[image: check.png] Ribbon that contains the bulk of the Excel commands arranged into a series of tabs ranging from Home through View.

				[image: check.png] Formula bar that displays the address of the current cell along with the contents of that cell.

				[image: check.png] Worksheet area that contains the cells of the worksheet identified by column headings using letters along the top and row headings using numbers along the left edge; tabs for selecting new worksheets; a horizontal scroll barto move left and right through the sheet; and a vertical scroll bar to move up and down through the sheet.

				[image: check.png] Status bar that keeps you informed of the program’s current mode and any special keys you engage, and enables you to select a new worksheet view and to zoom in and out on the worksheet.

				Going Backstage via File

				To the immediate left of the Home tab on the Ribbon right below the Quick Access toolbar, you find the File tab.

				When you click File, the new Backstage View opens. This view contains a menu similar to the one shown in Figure 1-2. When you open the Backstage View, the Info option displays at-a-glance stats about the Excel workbook file you have opened and active in the program.

				This information panel is divided into two panes. The pane on the left contains large buttons that enable you to modify the workbook’s permissions, distribution, and versions. The pane on the right contains a thumbnail of the workbook followed by a list of fields detailing the workbook’s various Document Properties, some of which you can change (such as Title, Tags, Categories, and Author), and many of which you can’t (such as Size, Last Modified, Created, and so forth).

				Above the Info option, you find the commands (Save, Save As, Open, and Close) you commonly need for working with Excel workbook files. Near the bottom, the File tab contains a Help option that, when selected, displays a Support panel in the Backstage View. This panel contains options for getting help on using Excel, customizing its default settings, as well as checking for updates to the Excel 2010 program. Below Help, you find options that you can select to change the program’s settings, along with an Exit option that you can select when you’re ready to close the program.

				[image: 9781118315248-fg0102.tif]

				Figure 1-2: Open Backstage View to get at-a-glance information about the current file, access all file-related commands, and modify the program options.

				
					
				

				[image: Tip.eps]Click the Recent option to continue editing an Excel workbook you’ve worked on of late. When you click the Recent option, Excel displays a panel with a list of all the workbook files recently opened in the program. To re-open a particular file for editing, all you do is click its filename in this list.

				[image: remember.eps]	To close the Backstage View and return to the normal worksheet view, you can click the File tab a second time or simply press the Escape key.

				Bragging about the Ribbon

				The Ribbon (shown in Figure 1-3) changes the way you work in Excel 2010. Instead of having to memorize (or guess) on which pull-down menu or toolbar Microsoft put the particular command you want to use, their designers and engineers came up with the Ribbon that shows you the most commonly used options needed to perform a particular Excel task.

				[image: 9781118315248-fg0103.eps]

				Figure 1-3: Excel’s Ribbon consists of a series of tabs containing command buttons arranged into different groups.

				The Ribbon contains the following components:

				[image: check.png] Tabs for each of Excel’s main tasks that bring together and display all the commands commonly needed to perform that core task.

				[image: check.png] Groups that organize related command buttons into subtasks normally performed as part of the tab’s larger core task.

				[image: check.png] Command buttons within each group that you select to perform a particular action or to open a gallery from which you can click a particular thumbnail. Note: Many command buttons on certain tabs of the Ribbon are organized into mini-toolbars with related settings.

				[image: check.png] Dialog box launcher in the lower-right corner of certain groups that opens a dialog box containing a bunch of additional options you can select.

				[image: Tip.eps]	To display more of the Worksheet area in the program window, you can minimize the Ribbon so that only its tabs display. Simply click the Minimize the Ribbon button, the first button with what looks like a greater-than symbol pointing upward in the group of buttons for minimizing, maximizing, and closing the current worksheet window to the right of the Ribbon tabs and to the immediate left of the Help button. You can also double-click any one of the Ribbon’s tabs, or just press Ctrl+F1. To redisplay the entire Ribbon, and keep all the command buttons on its tabs displayed in the program window, click the Expand the Ribbon button, double-click one of the tabs, or press Ctrl+F1 a second time.

				[image: remember.eps]	When you work in Excel with the Ribbon minimized, the Ribbon expands each time you click one of its tabs to show its command buttons, but that tab stays open only until you select one of the command buttons. The moment you select a command button, Excel immediately minimizes the Ribbon again and just displays its tabs.

				Keeping tabs on the Excel Ribbon

				The first time you launch Excel 2010, its Ribbon contains the following tabs from left to right:

				[image: check.png] Home tab with the command buttons normally used when creating, formatting, and editing a spreadsheet, arranged into the Clipboard, Font, Alignment, Number, Styles, Cells, and Editing groups.

				[image: check.png] Insert tab with the command buttons normally used when adding particular elements (including graphics, PivotTables, charts, hyperlinks, and headers and footers) to a spreadsheet, arranged into the Tables, Illustrations, Charts, Sparklines, Filter, Links, Text, and Symbols groups.

				[image: check.png] Page Layout tab with the command buttons normally used when preparing a spreadsheet for printing or re-ordering graphics on the sheet, arranged into the Themes, Page Setup, Scale to Fit, Sheet Options, and Arrange groups.

				[image: check.png] Formulas tab with the command buttons normally used when adding formulas and functions to a spreadsheet or checking a worksheet for formula errors, arranged into the Function Library, Defined Names, Formula Auditing, and Calculation groups. Note: This tab also contains a Solutions group when you activate certain add-in programs, such as Analysis ToolPak and Euro Currency Tools.

				[image: check.png] Data tab with the command buttons normally used when importing, querying, outlining, and subtotaling the data placed into a worksheet’s data list, arranged into the Get External Data, Connections, Sort & Filter, Data Tools, and Outline groups. Note: This tab also contains an Analysis group when you activate add-ins, such as Analysis ToolPak and Solver.

				[image: check.png] Review tab with the command buttons normally used when proofing, protecting, and marking up a spreadsheet for review by others, arranged into the Proofing, Language, Comments, and Changes groups. Note: This tab also contains an Ink group with a sole Start Inking button when you’re running Office 2010 on a Tablet PC or a computer equipped with a digital ink tablet.

				[image: check.png] View tab with the command buttons normally used when changing the display of the Worksheet area and the data it contains, arranged into the Workbook Views, Show, Zoom, Window, and Macros groups.

				[image: remember.eps]	In addition to these standard seven tabs, Excel has an eighth, optional Developer tab that you can add to the Ribbon if you do a lot of work with macros and XML files. 

				Although these standard tabs are the ones you always see on the Ribbon when it displays in Excel, they aren’t the only things that can appear in this area. Excel can display contextual tools when you’re working with a particular object that you select in the worksheet, such as a graphic image you’ve added or a chart or PivotTable you’ve created. The name of the contextual tools for the selected object appears immediately above the tab or tabs associated with the tools.

				For example, Figure 1-4 shows a worksheet after you click the embedded chart to select it. As you can see, doing this adds the contextual tool called Chart Tools to the very end of the Ribbon. The Chart Tools contextual tool has its own three tabs: Design (selected), Layout, and Format. Note, too, that the command buttons on the Design tab are arranged into groups Type, Data, Chart Layouts, Chart Styles, Location, and Mode.

				[image: 9781118315248-fg0104.eps]

				Figure 1-4: When you select certain objects in the worksheet, Excel adds contextual tools to the Ribbon with their own tabs, groups, and command buttons.

				[image: remember.eps]	The moment you deselect the object (usually by clicking somewhere outside the object’s boundaries), the contextual tool for that object and all its tabs immediately disappear from the Ribbon, leaving only the regular tabs — Home, Insert, Page Layout, Formulas, Data, Review, and View — displayed.

				Selecting commands from the Ribbon

				The most direct method for selecting commands on the Ribbon is to click the tab that contains the command button you want and then click that button in its group. For example, to insert a piece of clip art into your spreadsheet, you click the Insert tab and then click the Clip Art button to open the Clip Art task pane in the Worksheet area.

				The easiest method for selecting commands on the Ribbon — if you know your keyboard well — is to press the Alt key and then type the sequence of letters designated as the hot keys for the desired tab and associated command buttons.

				When you press and release the Alt key, Excel displays the hot keys for all the tabs on the Ribbon. When you type one of the Ribbon tab hot keys to select it, all the command button hot keys appear along with the hot keys for the dialog box launchers (see Figure 1-5). To select a command button or dialog box launcher, simply type its hot key letter(s).

				[image: 9781118315248-fg0105.eps]

				Figure 1-5: Excel hot keys for selecting command buttons and dialog box launchers.

				[image: remember.eps]	If you know the old Excel shortcut keys from versions Excel 97 through 2003, you can still use them. For example, instead of going through the rigamarole of pressing Alt+HC to copy a cell selection to the Office Clipboard and then Alt+HV to paste it elsewhere in the sheet, you can still press Ctrl+C to copy the selection and then press Ctrl+V when you’re ready to paste it. Note, however, that when using a hot key combination with the Alt key, you don’t need to keep the Alt key depressed while typing the remaining letter(s) as you do when using a shortcut key combo with the Ctrl key.

				Customizing the Quick Access toolbar

				When you start using Excel 2010, the Quick Access toolbar contains only the following few buttons:

				[image: check.png] Save to save any changes made to the current workbook using the same filename, file format, and location

				[image: check.png] Undo to undo the last editing, formatting, or layout change you made

				[image: check.png] Redo to reapply the previous editing, formatting, or layout change that you just removed with the Undo button

				The Quick Access toolbar is very customizable because Excel makes it easy to add any Ribbon command to it. Moreover, you’re not restricted to adding buttons for just the commands on the Ribbon; you can add any Excel command you want to the toolbar, even the obscure ones that don’t rate an appearance on any of its tabs.

				[image: Tip.eps]	By default, the Quick Access toolbar appears above the Ribbon tabs immediately to the right of the Excel program button (used to resize the workbook window or quit the program). To display the toolbar beneath the Ribbon immediately above the Formula bar, click the Customize Quick Access Toolbar button (the drop-down button to the right of the toolbar with a horizontal bar above a down-pointing triangle), and then click Show Below the Ribbon on its drop-down menu. You will definitely want to make this change if you start adding more buttons to the toolbar so that the growing Quick Access toolbar doesn’t start crowding the name of the current workbook that appears to the toolbar’s right.

				Adding command buttons on the Customize  Quick Access toolbar’s drop-down menu

				When you click the Customize Quick Access Toolbar button, a drop-down menu appears, containing the following commands:

				[image: check.png] New to open a new workbook

				[image: check.png] Open to display the Open dialog box for opening an existing workbook

				[image: check.png] Save to save changes to your current workbook

				[image: check.png] E-mail to open your mail

				[image: check.png] Quick Print to send the current worksheet to your default printer

				[image: check.png] Print Preview to open the Print settings in Backstage View with a preview of the current worksheet in the right pane

				[image: check.png] Spelling to check the current worksheet for spelling errors

				[image: check.png] Undo to undo your latest worksheet edit

				[image: check.png] Redo to reapply the last edit that you removed with Undo

				[image: check.png] Sort Ascending to sort the current cell selection or column in A to Z alphabetical order, lowest to highest numerical order, or oldest to newest date order

				[image: check.png] Sort Descending to sort the current cell selection or column in Z to A alphabetical order, highest to lowest numerical order, or newest to oldest date order

				When you open this menu, only the Save, Undo, and Redo options are selected (indicated by the check marks); therefore, these buttons are the only buttons to appear on the Quick Access toolbar. To add any of the other commands on this menu to the toolbar, you simply click the option on the drop-down menu. Excel then adds a button for that command to the end of the Quick Access toolbar (and a check mark to its option on the drop-down menu).

				To remove a command button that you add to the Quick Access toolbar in this manner, click the option a second time on the Customize Quick Access Toolbar button’s drop-down menu. Excel removes its command button from the toolbar and the check mark from its option on the drop-down menu.

				Adding command buttons on the Ribbon

				To add a Ribbon command to the Quick Access toolbar, simply right-click its command button on the Ribbon and then click Add to Quick Access Toolbar on its shortcut menu. Excel then immediately adds the command button to the very end of the Quick Access toolbar, immediately in front of the Customize Quick Access Toolbar button.

				If you want to move the command button to a new location on the Quick Access toolbar or group it with other buttons on the toolbar, click the Customize Quick Access Toolbar button and then click the More Commands option near the bottom of its drop-down menu.

				Excel then opens the Excel Options dialog box with the Quick Access Toolbar tab selected (similar to the one shown in Figure 1-6). On the right side of the dialog box, Excel shows all the buttons added to the Quick Access toolbar. The order in which they appear from left to right on the toolbar corresponds to the top-down order in the list box.

				To reposition a particular button on the toolbar, click it in the list box on the right and then click either the Move Up button (the one with the black triangle pointing upward) or the Move Down button (the one with the black triangle pointing downward) until the button is promoted or demoted to the desired position on the toolbar.

				[image: Tip.eps]	You can add vertical separators to the toolbar to group related buttons. To do this, click the <Separator> option in the list box on the left and then click the Add button twice to add two. Then, click the Move Up or Move Down button to position one of the two separators at the beginning of the group and the other at the end.

				To remove a button added from the Ribbon, right-click it on the Quick Access toolbar and then click the Remove from Quick Access Toolbar option on its shortcut menu.

				[image: 9781118315248-fg0106.eps]

				Figure 1-6: Use the buttons on the Quick Access Toolbar tab of the Excel Options dialog box to customize the appearance of the Quick Access toolbar.

				Adding non-Ribbon commands to  the Quick Access toolbar

				You can also use the options on the Quick Access Toolbar tab of the Excel Options dialog box (refer to Figure 1-6) to add a button for any Excel command even if it isn’t one of those displayed on the tabs of the Ribbon:

					1.	Click the type of command you want to add to the Quick Access toolbar in the Choose Commands From drop-down list box.

						The types of commands include the Popular Commands pull-down menu (the default) as well as each of the tabs that appear on the Ribbon. To display only the commands that are not displayed on the Ribbon, click Commands Not in the Ribbon near the top of the drop-down list. To display a complete list of the Excel commands, click All Commands near the top of the drop-down list.

					2.	Click the command whose button you want to add to the Quick Access toolbar in the list box on the left.

					3.	Click the Add button to add the command button to the bottom of the list box on the right.

					4.	(Optional) To reposition the newly added command button so that it isn’t the last one on the toolbar, click the Move Up button until it’s in the desired position.

					5.	Click the OK button to close the Excel Options dialog box.

				[image: Tip.eps]	If you’ve created favorite macros that you routinely use and want to be able to run directly from the Quick Access toolbar, click Macros in the Choose Commands From drop-down list box in the Excel Options dialog box and then click the name of the macro to add, followed by the Add button.

				Having fun with the Formula bar

				The Formula bar displays the cell address (determined by a column letter(s) followed by a row number) and the contents of the current cell. For example, cell A1 is the first cell of each worksheet at the intersection of column A and row 1; cell XFD1048576 is the last cell of each worksheet at the intersection of column XFD and row 1048576. The type of entry you make determines the contents of the current cell: text or numbers, for example, if you enter a heading or particular value, or the details of a formula if you enter a calculation.

				The Formula bar has three sections:

				[image: check.png] Name box: The left-most section that displays the address of the current cell address.

				[image: check.png] Formula bar buttons: The second, middle section that appears as a rather nondescript button displaying only an indented circle on the left (used to narrow or widen the Name box) and the Insert Function button (labeled fx) on the right. When you start making or editing a cell entry, Cancel (an X) and Enter (a check mark) buttons appear between them.

				[image: check.png] Cell contents: The third, right-most white area to the immediate right of the Insert Function button takes up the rest of the bar and expands as necessary to display really long cell entries that won’t fit in the normal area.

				[image: remember.eps]	The cell contents section of the Formula bar is important because it always shows you the contents of the cell even when the worksheet does not. (When you’re dealing with a formula, Excel displays only the calculated result in the cell in the worksheet and not the formula by which that result is derived.) Additionally, you can edit the contents of the cell in this area at anytime. Similarly, when the cell contents area is blank, you know that the cell is empty as well.

				What to do in the Worksheet area

				The Worksheet area is where most of the Excel spreadsheet action takes place because it’s the place that displays the cells in different sections of the current worksheet and it’s right inside the cells that you do all your spreadsheet data entry and formatting, not to mention a great deal of your editing.

				[image: remember.eps]	To enter or edit data in a cell, that cell must be current. Excel indicates that a cell is current in three ways:

				[image: check.png] The cell cursor — the dark black border surrounding the cell’s entire perimeter — appears in the cell.

				[image: check.png] The address of the cell appears in the Name box of the Formula bar.

				[image: check.png] The cell’s column letter(s) and row number are shaded (in a kind of an orange-beige color on most monitors) inthe column headings and row headings that appear at the top and left of the Worksheet area, respectively.

				Moving around the worksheet

				An Excel worksheet contains far too many columns and rows for all a worksheet’s cells to be displayed at one time regardless of how large your personal computer monitor screen is or how high the screen resolution. (After all, we’re talking 17,179,869,184 cells total!) Therefore, Excel offers many methods for moving the cell cursor around the worksheet to the cell where you want to enter new data or edit existing data:

				[image: check.png] Click the desired cell — assuming that the cell is displayed within the section of the sheet visible in the Worksheet area.

						Click the Name box, type the address of the desired cell, and then press the Enter key.

				[image: check.png] Press F5 to open the Go To dialog box, type the address of the desired cell into its Reference text box, and then click OK.

				[image: check.png] Use the cursor keys, as shown in Table 1-1, to move the cell cursor to the desired cell.

				[image: check.png] Use the horizontal and vertical scroll bars at the bottom and right edge of the Worksheet area to move the part of the worksheet that contains the desired cell, and then click the cell to put the cell cursor in it.

				Keystroke shortcuts for moving the cell cursor

				Excel offers a wide variety of keystrokes for moving the cell cursor to a new cell. When you use one of these keystrokes, the program automatically scrolls a new part of the worksheet into view, if this is required to move the cell pointer. In Table1-1, I summarize these keystrokes, including how far each one moves the cell pointer from its starting position.

				

				[image: Table 1-1 Keystrokes for Moving the Cell Cursor]

				[image: Tip.eps]	When you use Ctrl and an arrow key to move around in a table, you hold down Ctrl while you press one of the four arrow keys (indicated by the + symbol in keystrokes, such as Ctrl+→).

				When you use End and an arrow-key alternative, you must press and then release the End key before you press the arrow key (indicated by the comma in keystrokes, such as End, →). Pressing and releasing the End key causes the End Mode indicator to appear on the status bar. This is your sign that Excel is ready for you to press one of the four arrow keys.

				[image: remember.eps]	You can use the Scroll Lock key to “freeze” the position of the cell pointer in the worksheet so that you can scroll new areas of the worksheet in view with keystrokes, such as PgUp (Page Up) and PgDn (Page Down), without changing the cell pointer’s original position. (In essence, making these keystrokes work in the same manner as the scroll bars.)

				After engaging Scroll Lock, when you scroll the worksheet with the keyboard, Excel does not select a new cell while it brings a new section of the worksheet into view. To “unfreeze” the cell pointer when scrolling the worksheet via the keyboard, you just press the Scroll Lock key again.

				Tips on using the scroll bars

				To understand how scrolling works in Excel, imagine its humongous worksheet as a papyrus scroll attached to rollers on the left and right. To bring into view a section of papyrus hidden on the right, you crank the left roller until the section with the cells that you want to see appears. Likewise, to scroll into view a worksheet section hidden on the left, you crank the right roller until the section of cells appears.

				You can use the horizontal scroll bar at the bottom of the Worksheet area to scroll back and forth through the columns of a worksheet and the vertical scroll bar to scroll up and down through its rows. To scroll a column or a row at a time in a particular direction, click the appropriate scroll arrow at the ends of the scroll bar. To jump immediately back to the originally displayed area of the worksheet after scrolling through single columns or rows in this fashion, simply click the area in the scroll bar that now appears in front of or after the scroll bar. 

				[image: remember.eps]	You can resize the horizontal scroll bar making it wider or narrower by dragging the button that appears to the immediate left of its left scroll arrow. Just keep in mind when working in a workbook that contains a whole bunch of worksheets that widening the horizontal scroll bar can hide the display of the workbook’s later sheet tabs.

				[image: Tip.eps]	To scroll very quickly through columns or rows of the worksheet, hold down the Shift key, and then drag the scroll button in the appropriate direction within the scroll bar until the columns or rows that you want to see appear on the screen in the Worksheet area. When you hold down the Shift key while you scroll, the scroll button within the scroll bar becomes skinny and a ScreenTip appears next to the scroll bar, keeping you informed of the letter(s) of the columns or the numbers of the rows that you’re whizzing through.

				If your mouse has a wheel, you can use it to scroll directly through the columns and rows of the worksheet without using the horizontal or vertical scroll bars. Simply position the white cross mouse pointer in the center of the Worksheet area and then hold down the wheel button of the mouse. When the mouse pointer changes to a four-pointed arrow with a black dot in its center, drag the mouse pointer in the appropriate direction (left and right to scroll through columns or up and down to scroll through rows) until the desired column or row comes into view in the Worksheet area.

				[image: remember.eps]	The only disadvantage to using the scroll bars to move around is that the scroll bars bring only new sections of the worksheet into view — they don’t actually change the position of the cell cursor. If you want to start making entries in the cells in a new area of the worksheet, you still have to remember to select the cell (by clicking it) or the group of cells (by dragging through them) where you want the data to appear before you begin entering the data.

				Surfing the sheets in a workbook

				Each new workbook you open in Excel 2010 contains three blank worksheets, each with its own 16,384 columns and 1,048,576 rows (giving you a truly staggering 51,539,607,552 blank cells!). But, that’s not all. If ever you need more worksheets in your workbook, you can add them simply by clicking the Insert Worksheet button that appears to the immediate right of the last sheet tab (see Figure 1-7) or by pressing Shift+F11.

				[image: 9781118315248-fg0107.eps]

				Figure 1-7: The Sheet Tab scroll buttons, sheet tabs, and Insert Worksheet button enable you to activate your worksheets and add to them.

				One reason for adding extra sheets to a workbook

				You may wonder why anyone would ever need more than three worksheets given just how many cells each individual sheet contains. The truth is that it’s all about how you choose to structure a particular spreadsheet rather than running out of places to put the data. For example, suppose that you need to create a workbook that contains budgets for all the various departments in your corporation, you may decide to devote an individual worksheet to each department (with the actual budget spreadsheet tables laid out in the same manner on each sheet) rather than placing all the tables in different sections of the same sheet. Using this kind of one-sheet-per-budget layout makes it much easier for you to find each budget, print each one as a separate page of a report, and, if ever necessary, to consolidate the data in a separate summary worksheet.



				On the left side of the bottom of the Worksheet area, the Sheet Tab scroll buttons appear followed by the actual tabs for the worksheets in your workbook and the Insert Worksheet button. To activate a worksheet for editing, you select it by clicking its sheet tab. Excel lets you know what sheet is active by displaying the sheet name in boldface type and making its tab appear on top of the others.

				[image: Tip.eps]	Don’t forget the Ctrl+Page Down and Ctrl+Page Up shortcut keys for selecting the next and previous sheet, respectively, inyour workbook.

				If your workbook contains too many sheets for all the tabs to display at the bottom of the Worksheet area, use the Sheet Tab scroll buttons to bring new tabs into view (so that you can then click them to activate them). You click the Next Sheet button to scroll the next hidden sheet tab into view or the Last Sheet button to scroll the last group of completely or partially hidden tabs into view.

				Showing off the Status bar

				The Status bar is the last component at the very bottom of the Excel program window (see Figure 1-8). The Status bar contains the following:

				[image: check.png] Mode indicator that shows the current state of the Excel program (Ready, Edit, and so on) as well as any special keys that are engaged (Caps Lock, Num Lock, and Scroll Lock).

				[image: check.png] AutoCalculate indicator that displays the average and sum of all the numerical entries in the current cell selection along with the count of every cell in the selection.

				[image: check.png] Layout selector that enables you to select between three layouts for the Worksheet area: Normal, the default view that shows only the worksheet cells with the column and row headings; Page Layout View that adds rulers, page margins, and shows page breaks for the worksheet; and Page Break Preview that enables you to adjust the paging of a report. (See Chapter 5 for details.)

				[image: check.png] Zoom slider that enables you to zoom in and out on the cells in the Worksheet area by dragging the slider to the right or left, respectively.

				[image: 9781118315248-fg0108.eps]

				Figure 1-8: The Status bar displays the program’s current standing and enables you to select new worksheet views.

				[image: Tip.eps]	The Num Lock indicator tells you that you can use the numbers on the numeric keypad for entering values in the worksheet. This keypad will most often be separate from the regular keyboard (on the right side if you’re using a separate keyboard) and embedded in keys on the right side of the keyboard on almost all laptop computers where the keyboard is built in to the computer.

				Launching and Quitting Excel

				Excel 2010 runs under both the older Windows XP operating system and the newer Vista and Windows 7 operating systems. Because of changes made to the Start menu in Windows Vista and Windows 7, the procedure for starting Excel from these versions of Windows is a bit different from Windows XP.

				Starting Excel from  the Start menu

				You can use the Start Search box at the bottom of the Windows Vista Start menu or the Search Programs and Files search box on the Windows 7 Start menu to locate Excel on your computer and launch the program in no time at all:

					1.	Click the Start button on the Windows taskbar to open the Windows Start menu.

					2.	Click the Start menu’s search text box and type the letters exc to have Windows locate Microsoft Office Excel 2010 on your computer.

					3.	Click the Microsoft Excel 2010 option that now appears in the left Programs column on the Start menu.

				If you have more time on your hands, you can also launch Excel from the Windows Start menu by going through the rigmarole of clicking StartAll ProgramsMicrosoft OfficeMicrosoft Excel 2010.

				Starting Excel from the Windows XP Start menu

				When starting Excel 2010 from the Windows XP Start menu, you follow these simple steps:

					1.	Click the Start button on the Windows taskbar to open the Windows Start menu.

					2.	With the mouse, highlight All Programs on the Start menu and then Microsoft Office on the Start continuation menu before clicking the Microsoft Excel 2010 option on the Microsoft Office continuation menu.

				Pinning a Microsoft Excel 2010 option on your Windows Start menu

				If you use Excel all the time, you may want to make its program option a permanent part of the Windows Start menu. To do this, you pin the program option to the Start menu (and the steps for doing this are the same in Windows XP as they are in Windows Vista and Windows 7):

					1.	Click the Windows Start button and then highlight the All Programs option on the Start menu.

						Windows XP opens a continuation menu from its Start menu and Windows Vista and Windows 7 display a new menu of program options on their Start menus.

					2.	Highlight the Microsoft Office option on the Windows XP continuation menu or click the Microsoft Office option on the Windows Vista/7 Start menu.

						Windows XP displays a continuation menu with a list of all the Office 2010 programs installed on your computer. Windows Vista and Windows 7 display a submenu listing the Office 2010 programs.

					3.	Right-click Microsoft Excel 2010 on the Windows continuation or submenu to open its shortcut menu.

					4.	Click Pin to Start Menu on the shortcut menu.

				[image: remember.eps]	After pinning Excel in this manner, the Microsoft Excel 2010 option always appears in the upper section of the left-hand column of the Windows Start menu and you can then launch Excel simply by clicking the Windows Start button and then clicking this menu option.

				
					
				

				[image: Tip.eps]After you pin the Microsoft Excel 2010 option on to the Windows 7 Start menu, whenever you highlight this menu item, Windows 7 automatically expands the Start menu to display a list of your recently opened Excel workbook files. You can then open one of these files for further editing at the same time you launch the Excel 2010 program by clicking its filename on the Start menu.

				Adding a Microsoft Excel 2010 shortcut to your Windows desktop

				Some people prefer having the Excel program icon appear on the Windows desktop so that they can launch the program from the desktop by double-clicking this program icon. To create a Microsoft Excel 2010 program shortcut for your Windows desktop, you follow these steps:

					1.	Click the Windows Start button and then highlight the All Programs option on the Start menu.

						Windows XP opens a continuation menu from its Start menu and Windows Vista and Windows 7 display a new menu of program options on their Start menus.

					2.	Highlight the Microsoft Office option on the Windows XP continuation menu or select the Microsoft Office option from the Windows Vista/Windows 7 Start menu.

						Windows XP displays a continuation menu with a list of all the Office 2010 programs installed on your computer. Windows Vista and Windows 7 display a submenu listing the Office 2010 programs.

					3.	Right-click Microsoft Excel 2010 on the Windows continuation or submenu to open its shortcut menu.

					4.	Highlight the Send To option on this menu and then click Desktop (Create Shortcut) on the continuation shortcut menu.

						Windows adds a Microsoft Excel 2010 shortcut icon to your Windows desktop that launches the program when you double-click it or right-click it and then click the Open option.

				Adding Excel to the Windows Quick Launch toolbar

				If you want to be able to launch Excel 2010 by clicking a single button, drag the Excel icon for your Windows Vista or Windows XP desktop shortcut to the Quick Launch toolbar to the immediate right of the Start button at the beginning of the Windows taskbar. When you position the icon on this toolbar, Windows indicates where the new Excel button will appear by drawing a black, vertical I-beam in front of or between the existing buttons on this bar. As soon as you release the mouse button, Windows adds an Excel 2010 button to the Quick Launch toolbar that enables you to launch the program by a single click of its icon.

				Pinning an Excel icon to the Windows 7 taskbar

				If your computer is running Windows 7, you can add a Microsoft Excel 2010 icon to the taskbar in addition to the standard Internet Explorer, Windows Explorer, and Windows Media Player buttons.

				All you do is drag and drop the Microsoft Excel 2010 icon that either you pinned to the Windows Start menu or you added as a shortcut to the Windows desktop into its desired position on the Windows 7 taskbar. (See “Pinning a Microsoft Excel 2010 option on your Windows Start menu” and “Adding a Microsoft Excel 2010 shortcut to your Windows desktop,” earlier in this chapter for details.)

				[image: remember.eps]	After pinning a Microsoft Excel 2010 icon to the Windows 7 taskbar, the button appears on the Windows taskbar each time you start your computer, and you can launch the Excel program simply by single clicking its icon.

				Exiting Excel

				When you’re ready to call it a day and quit Excel, you have three choices for shutting down the program:

				[image: check.png] Choose FileExit.

				[image: check.png] Press Alt+FX or Alt+F4.

				[image: check.png] Click the Close button (the X) in the upper-right corner of the Excel program window. 

				If you try to exit Excel after working on a workbook and you haven’t saved your latest changes, the program displays an alert box querying whether you want to save your changes. To save your changes before exiting, click the Save command button. (For detailed information on saving documents, see Chapter 2.) If you’ve just been playing around in the worksheet and don’t want to save your changes, you can abandon the document by clicking the Don’t Save button.

				Help Is on the Way

				You can get online help with Excel 2010 anytime that you need it while using the program. Simply click the Help button (the button with the question mark icon to the immediate right of the Minimize the Ribbon button on the right side of the program window opposite the Ribbon’s tabs) or press F1 to open a separate Excel Help window. (See Figure 1-9.)

				When the Excel Help window opens, Excel attempts to use your Internet connection to update its topics. The opening Help window contains links that you can click to get information on what’s new in the program.

				To get help with a particular command or function, use the Search text box at the top of the Excel Help window. Type keywords or a phrase describing your topic (such as “print preview” or “printing worksheets”) in this text box and then press Enter or click the Search button. The Excel Help window then presents a list of links to related help topics that you can click to display the information.

				[image: Tip.eps]	To print the help topic displayed in the Excel Help window, click the Print button (with the printer icon) on its toolbar. Excel then opens a Print dialog box where you can select the printer and options to use in printing the information.

				[image: 9781118315248-fg0109.tif]

				Figure 1-9: The Excel Help window automatically connects you to the Internet when you open it.

				To display a table of contents with all the main categories and subtopics arranged hierarchically, click the Show Table of Contents button (with the book icon) on the toolbar.
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What's Going On Here?

Appears when the formula calls for division by a cell
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the case, is empty. Division by zero is a no-no in
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#NAME?

Appears when the formula refers to a range name
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in the formula, causing Excel to think that the text
refers to a range name.

#NULL!

#NUM!

Appears most often when you insert a space (where
you should have used a comma) to separate cell ref-
erences used as arguments for functions.

Appears when Excel encounters a problem with a
number in the formula, such as the wrong type of
argument in an Excel function or a calculation that
produces a number too large or too small to be rep-
resented in the worksheet.
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Keystroke

Where the Cell Cursor Moves

—orTab Cell to the immediate right.

« or Shift+Tab Cell to the immediate left.

T Cell up one row.

l Cell down one row.

Home Cell in Column A of the current row.

Ctrl+Home First cell (A1) of the worksheet.

Ctrl+End or End, Cell in the worksheet at the intersection of the

Home last column that has data in it and the last row
that has data in it (that is, the last cell of the so-
called active area of the worksheet).

Page Up Cell one full screen up in the same column.

Page Down Cell one full screen down in the same column.

Note: In the case of those keystrokes that use arrow keys, you must either use
the arrows on the cursor keypad or else have the Num Lock disengaged on the
numeric keypad of your keyboard.
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